eveoLIS

USER GUIDE

Evolis Driver
on MACINTOSH?®

FOR END-USERS

For more information, please visit www.evolis.com


https://www.edikio.com/

Table of Contents

1. Introduction
2. Copyright and Trademark
3. How To Use This Guide

3.1 Informative Icons
3.2 Glossary 5
4. Minimum Requirements
5. Possible Configurations
6. Driver Installation
6.1 Finding the Driver Setup File 10
6.2 Checking Your Current Driver Version 10
6.3 Running the Installation Wizard 11
7. Installing Evolis Color Profile
8. Configuration of the Connection
8.1 USB Connection 16
8.2 LAN Connection 16
8.2.1 Checklist Before Starting 17
8.2.2 Setting a Fixed IP Address on the Printer 17
8.2.2.1 Collecting the Required Information 17
8.2.2.2 Configuring your Printer IP Address 18
8.23 Setting a DHCP Address on the Printer 19
8.2.3.1 Configuring DHCP address 19
8.2.4 Using a Switch 20
825 Adding the Printer to the List 21
8.2.6 Checking Connection With the Printer 24
83 Assigning the Driver Version 25
9. Accessing Printing Settings
10. Changing Printer Properties
10.1 General 32
10.1.1 Rotate 32
10.1.2 Cards Feeding/Exit 34
10.1.2.1 Card Insertion 34
10.1.22 Card Exit 35

User-Guide_EvolisDriver_Macintosh ENG 2021123



Table of Contents

35

36

37

37

39
39
43
46
47

47
47

48

10.1.2.3 Card ejected in error
10.1.2.4 Card Pre-Loading
10.1.2.5 Specific Settings for Kiosk (KM2000) printer
10.1.2.6 Specific Settings for Kiosk (KC) printers
10.2 Ribbon
10.2.1 Ribbon Manual Selection
10.2.2 Duplex Mode
10.2.3 Printing Resolution
10.3 Graphical Settings
10.3.1 Front Side/Back Side Graphical Settings
10.3.1.1 Brightness and Contrast
10.3.1.2 Black Panel Adjustment
10.3.13 Printing Black Text: Use of Different Softwares
10.4 Varnish adjustment

50

10.5 Magnetic Encoding

10.5.1 Encoding Using Cardpresso

10.5.2 Encoding Properties

11. Accessing the ComTool

11.1 Sending Direct Commands in the Comtool

11.2 Upgrading Firmwares in the Comtool

12. Troubleshooting

12.1 Connection Issues
12.2 Printing Issues
12.2.1 Faded Colors
12.2.2 Torn Ribbon
12.23 Unreadable Barcode

User-Guide_EvolisDriver_Macintosh ENG 2021123

53
54
55
57

60
61

63
63
63

64
65



This guide is intended for end-users with the following objectives:
The version of driver documented in the current User Guide is the setup version 6.8.1.181.

The .pkg file is available on Evolis support website.

Evolis printers that are managed by the driver are the following:
e Primacy 1, Primacy 2, Zenius, Elypso, KC100, KC200, KM500B, KM2000B
e Badgy100 and Badgy200
o Edikio Access, Duplex and Flex
e KC Essential/KC Prime

NOTE Features of the driver may vary depending on the type of printer you use.
Evolis printers have more or less possibilities depending on their type.

This User Guide describes all possible features offered by the range of printers listed
above.

© Evolis. All rights reserved.

Users must observe the copyright regulations applicable in their country. This manual must not be
photocopied, translated, reproduced, or transmitted, in whole or in part, for any reason and by any
electronic or mechanical means whatsoever without the express written consent of Evolis.

All the information contained in this document is subject to change without prior notice.

Evolis cannot be held liable for any loss or damage arising accidentally or as a result of dissemination
or use of this manual.

Driver Setup® and Evolis High Trust® are trademarks of Evolis. All other trademarks belong to their
respective holders.

3.1 Informative Icons

The following icons are used in this manual to highlight important information:

NOTE Information providing further details or depth about specific points in the main text of
the guide.

Warning
i:: Actions that are prohibited or dangerous to the product (loss of data, for example) or
=

the user (safety matter, for example).

The term attached to this icon has a definition in the glossary provided in the present
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guide.

USE CASE | Examples of use cases are provided throughout this user guide.
They will help you understand how to use Driver Setup and print your cards the best
way.

Indicates that a video showing the procedure is available on www.evolis.com website

3.2 Glossary

Term MEANING

Anti-aliasing | Type of smoothing technique that is specifically focused on text areas and
pictures. This settings is only available in Evolis card design softwares
(Cardpresso, Badge Studio, Edikio Price Tag).

Black dot Dots of the design that have RGB colors <253 and are printed with the K panel
only.

The threshold detected by Evolis driver for black and colored dots is RGB 253.
Colored dots have RGB color =253 and are printed with the YMC panels.

If necessary, this threshold may be changed in your card designing software.

Clustered Halftoning technique that converts a color image to one made up of group of

dithering | dots.
It produces a good quality image rendering at distance

Composite |Process usedto print the black color with a mix of colors: yellow, magenta and
Black cyan

Dithering Halftoning technique in which dots or pixels arrangement allows to perceive
more colors than are actually used.

dpi (dot per Number of dots that are placed in one inch on a card design.
inch)

Duplex Mode linked to a printer equipped with a flip-over module
Automatic front and back-side printing is possible

Dye Printing process in which ink is transformed in gas and spread on the card surface.
sublimation | Dyes of three separate color panels (YMC or Yellow, Magenta, Cyan) are used to
create millions of colors within the spectrum, from white to (non-pure) black.
Printing quality is dependent of the card quality, plastic composition and density.

Encoding Process to save data on a specific support (magnetic stripe, contact/contactless
chip).
No confusion should be made with the term "encryption".
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Term

MEANING

Some encoding systems are called "dual” : it means they offer contact as well as
contactless encoding

CL means "contactless"

CNT means "contact"

Encryption |Process toreplace data by another data that can be encrypted/decrypted
through a specific key.
For example, the key may be as follows: replacing the letter by the letter +2 in
the alphabet: A=C, B=D, C=E, D=etc.
Halftoning | Process that simulates shades of gray by varying the size of tiny black dots
arranged in a regular pattern (only available with a black ribbon)
Hologram |Advanced form of photography that allows an image to be recorded in three
dimensions
LCD Color touchscreen attached to the Primacy printer that informs the user about
(Liquid the operational status of the printer and enables to change the most common
Crystal settings. It also includes a switch on/off button to command the printer.
Display)
Native Driver | Simplified printer driver that is displayed and available by default through the
computer Control Panel or directly from an application.
CUPS on MACINTOSH®
Native driver | Evolis graphical interface of the native driver, available in all three modes but
printing particularly useful in Minimal Mode.
settings The list of settings in this interface is limited, but they are the default settings
when the printing job is not performed from an application with embarked
settings
Overlay / Film applied on the card after the printing process, to protect the card from UVs
Varnish and to increase resistance of cards to scratching and fading up.
It is applied through the "O"panel of the ribbon.
Panel Inaribbon, sequence of colors that is repeated.
The sequence of colors depends on the type of ribbon used.
For example, in a five-panel ribbon, the colors are the following: yellow,
magenta, cyan, black, overlay
PC/SC Standard for smart cards and card readers.
A smart contact card is a CR80 card with an integrated circuit.
Printing Process made by the printer to apply the design on the card.
Various techniques are used:
- dye sublimation combined and thermal transfer
- retransfer (only possible with Evolis retransfer printers)
Ribbon Ink support film made of various panels or a continuous one, depending on the

ribbon type. The film support can be a cassette or simple rolls.
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Term MEANING

With Evolis High Trust® ribbons, a zone code provides authentication and
identification of each ribbon.
During the printing process, dye sublimation and thermal transfer techniques are
used.

Simplex Printer with no flip-over module integrated or activated.
Front and back-side printing is possible, but the back-side print requires a
manual action of the user

Smoothing | Technique used to make more even the curbs on the pattern, soasto geta

clearer print rendering on the card.

Thermal Printing process in which ink is heated up to produce plastic resin and transferred

transfer onto the card surface. K (black) and O (overlay) panels are applied through this
technique.
For example, monochrome resinis applied on a YMC color design to produce a
dense black text or a barcode.
Card quality is less critical than for the dye sublimation process.

Varnish Type of lamination film available in a thickness that enables a two-year durability

(used for | ofthe card

lamination) This type of film:

- covers the full surface of the card (edge-to-edge covering)
- is compatible with PVC or composite cards
- is not compatible with smart contact cards or magnetic stripe cards

YMCKO Type of ribbon that contains the following panels: Yellow, Magenta, Cyan, Black,
Overlay
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OPERATING MacOS 11 (Big Sur)
SYSTEM MacOS X 10.15 (Catalina)
MacOS X 10.14 (Mojave)
MacOS X 10.13 (High Sierra)
MacOS X 10.12 (Sierra)

AVAILABLE SIZE

ON DISK 2132 MB

FIRMWARE Last firmware available on Evolis website

The driver and the firmware applicable to your printer are closely
,-‘ : 2 linked.

Please always make sure that the firmware installed on your
computer is up to date.

RIGHTS Administrative rights are compulsory on your computer.
NETWORK USB, Ethernet or Wi-Fi connection (refer to section Configuration of the

OPTIONS Connection)[ 16]
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https://fr.evolis.com/

Some printers managed by the driver have a USB port as well as an Ethernet port and some of them
have a USB port only (Badgy 100/200 and Edikio Access).
Only Primacy printer has an additional Wi-Fi option.

The type of port used is different according to the configuration:

- one printer on one computer

USB connection | I_
g U
- various printers on the same com puter

USB connection
| 5]
D l
e —

USB connection

- printer shared between various computers

E
D fhemet Cable
ol
\ -ﬂ-
b b |
\e
Crnernet ceb

Ethernet cable

=)
e

- through a switch: one or various printers with the Ethernet connection, on the same computer or
various computers

‘o
%
I
=

< )
s P
DEthemet cable Ethernet cable [ | [ [
- 6}6
€

I

—=of

1

For more details on the installation and configuration steps, see section Configuration of the
Connection[ 6]
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Please refer to section Minimum Requirements before starting the installation.

Plug the printer to the computer and make sure you are logged with the administrator rights.

6.1 Finding the Driver Setup File

Step 1: Go to the Evolis website, click on Drivers&Supports and select the printer that you are
currently using, then click on Drivers&Firmware.

the packaging of the product you have purchased from Evolis.
However, when you want to install the last version of the driver setup, you need to
download it from Evolis website as explained in the first steps.

NOTE I The driver setup file may also available on the CD-ROM/USB stick you were provided in

Evolis Printer Driver is made available through a .pkg file.
Step 2: Click on the link called Setup Version to download it.

Step 3: Go to next section to run the wizard.

6.2 Checking Your Current Driver Version

Before you decide to change the driver on your computer, you can check your current driver setup
version as follows:

Step 1: Click System Preferences in the Apple menu.

System Preferences
=3 III: |II .‘ ;
= = %

Step 2: Click Printer & Scanners.
Select the printer in the list and check the version on the right part:
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®0 4 i Printers & Scanners o]

EVOLIS Pri
EVOLIS Badgy200 rimacy

® Offline ! Open Print Queue...
« EVOLIS Edikio Access
" ® Offline Options & Supplies...
- EVOLIS Edikio Duplex
& Offling

1T EVOLIS Edikio Flex Evolis's Mac
M8 Pausad EVOLIS Pri UPS 6.6.2.138 English
[ EVOLIS Edikio Flex 2 ' SR e
_ = Offline ' Bk

H - EVOLIS Primacy

Idle, Default
Share this printer on the network Sharing Preferences...
J’_ -
Default printer: = EVOLIS F_'rim_ar_:g-l
Default paper size: | A4 ?

6.3 Running the Installation Wizard

Step 1: From the file explorer, right-click on the .pkg file to openit.

. “EvolisPrinterDriver-6.5.2.95.pkg" can't be
Ny i opened because it is from an unidentified
P developer.

Your security preferences allow installation of only
apps from the App Store and identified developers.

Safari downloaded this file on an unknown date.

? [ oK

If the following error message appears:

Hold the command key while clicking on the file and click on Open:

macOS cannot verify the
developer of
“EvolisPrinterDriver-6.6.2.138.
pkg". Are you sure you want to

open it?
By opening this app, you will be
. “EvolisPrinterDriver-6.5.2.95.pkg" is from overriding system security which can
Y i an unidentified developer. Are you sure you expose your computer and personal
p want to open it? information to malware that may harm
your Mac or compromise your privacy.

Opening “EvolisPrinterDriver-6.5.2.95.pkg"” will always
allow it to run on this Mac.

Safari downloaded this file on an unknown date.

om [

Step 2: Run the wizard to install the CUPS driver.
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® Introduction

Welcome to the EvolisPrinterDriver-6.6.2.138 Installer

software.

Step 3: Plug-in your printer power supply to the mains socket .

From the wizard, click on Continue.
[ )

an|

‘& Install EvolisPrinterDriver-6.6.2.138

e Vr.) L I s Important Information

This is a ReadMe for the EvolisPrinterDriver package.

You will be guided through the steps necessary to install this

Continue

i

-

]

® Introduction

EvolisPrinterDriver-6.6.2.138 package install the file inside the CUPS
© Read Me directory.
Destination Select Before starting the printer installation :
u . - plug in your printer and power it on.
| Installation Type - you need to have the root right to admin the CUPS server.
& Installation
Kt Summary
ui
m
10
§
l Print... Save... Go Back Continue
L

ev/.)L I s Standard Install on “OS X Base System”

o oaation This will take 13,2 MB of space on your computer.

Read Me Click Install to perform a standard installation of this software
on the disk “OS X Base System”.

Destination Select
Installation Type
Installation

Summary

Go Back Install

setF
igs

User-Guide_EvolisDriver_Macintosh ENG 2021123

12



[ ] '« Install EvolisPrinterDriver-6.6.2.138

The installation was completed successfully.
eveoLIs

Introduction

Read Me
Destination Select
Installation Type
Installation

@ Summary
The software was installed.

Go to next steps:
- USB Connection[ 161and Assigning the Driver Version 25)
- or LAN Connectionl 161and Assigning the Driver Version|2s)

User-Guide_EvolisDriver_Macintosh ENG 2021123
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Step 1: Go to Applications>Utilities>ColorSync Utility.

Step 2: From the list on the left, click on the printer.

e =

Profile First Aid Profiles Devices Filters Calculator

Registered ColorSync devices:

Device Default

» Scanners

> Cameras

» Displays

V Printers
EVOLIS Elypso
EVOLIS Primacy 2
EVOLIS Edikio Flex
192.168.1.116
EVOLIS Badgy200 3
EVOLIS Badgy200
EVOLIS Primacy $
EVOLIS Badgy200 2

Devices

Printer “EVOLIS Primacy”
ID: 00002882-0000-0000-0000-000000000000

Scope: Any user of any computer

Mode “RGB”

Factory Profile:
Name: unknown or remote profile

Path: Open

Current Profile: v
Name: EVOLIS

Path: [Library/ColorSync/Profiles/

Open
evolis_profil_v701.icc

Step 3: Click on Current Profile and select Other to assign the profile.
PR R

[ JON J Devices
< | N 1y
* Pcid Ll -
— Profile First Aid Profiles Devices Filters Calculator !;

Favorites

@ AirDroy Registered ColorSync devices: ’

0s X q Device Default | Printer “EVOLIS Primacy”

» Scanners ID: 0000-0000-0000-
@ Al » Cameras
Scope: Any user of any computer
& iCloud | | » Displays
V Printers

/; Applicd

7% APRig EVOLIS Elypso Mode “RGE"

[ Deskto EVOLIS Primacy 2 ode

@ Docum EVOLIS Edikio Flex Factory Profile:

192.168.1.116 | )

o Downld EVOLIS Badgy200 3 Name: unknown or remote profile
_ EVOLIS Badgy200 Path: Open

g EVOLIS Primacy D )

© Remot EVOLIS Badgy200 2 Current Profile: v/

Name: unknown or r( Other...

Shared

@ All Path: Open
Tags

Step 4: Search for the profile in the following path:
System>Library>ColorSync>evolis_profil_v701.icc

User-Guide_EvolisDriver_Macintosh ENG 2021123
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Lod

Back/Forward Quick Look

Favorites

@ AirDrop

B All My Files
& iCloud Drive

g =[] =
View Arrange

Application Support

Audio

Caches

ColorPickers

ColorSync

Components

Compositions

C Menu Items

[ Desktop

@ Documents

0 Downloads
Devices

Remote Disc
Shared

@ A

Tags

CoreMedialO
Desktop Pictures
DirectoryServices
Documentation
Extensions
Filesystems
Fonts
Frameworks
Graphics

Image Capture
Input Methods
Internet Plug-Ins

[ Profiles

Frae

Action

8 Poties |

=)
Share Add Tags Delete

» W Scripts

>

>

se=w=E ==

L AL

Q Search
Search

Black & White.icc
Blue Tone.icc
Displays
evolis_profil_v701.icc
Gray Tone.icc
Lightness Decrease.icc
Lightness Increase.icc
Sepia Tone.icc
WebSafeColors.icc

Step 5: The profile is now assigned to the printer.
eoe

¥ vEHe 3

Profile First Aid Profiles Devices Filters Calculator

Devices

Registered ColorSync devices:

Device

» Scanners

> Cameras

> Displays

V Printers
EVOLIS Elypso
EVOLIS Primacy 2
EVOLIS Edikio Flex
192.168.1.116
EVOLIS Badgy200 3
EVOLIS Badgy200
EVOLIS Primacy
EVOLIS Badgy200 2
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Default

Printer “EVOLIS Primacy”
ID: 00002882-0000-0000-0000-000000000000

Scope: Any user of any computer

Mode “RGB”

Factory Profile:

Name: unknown or remote profile

Path:

Current Profile: v

Name: EVOLIS

Path: [Library/ColorSync/Profiles/
evolis_profil_v701.icc

Open

Open
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This section explains how to configure your printer(s) and computer(s) through different types of
connections (point-to-point or network) and communication (USB, Ethernet, Wi-Fi).

You may have some additional information in the following document: Network Administrator

Manual.

8.1 USB Connection

This type of connection is the most frequently used.

You can use it with:
- one printer

USB connection

- various printers: depending on the number of USB ports on your computer

USB connection N L
D B | B

USB connection

—of

A

If you use a USB switch, please be aware that all models are not supported by Evolis
configurations today.

8.2 LAN Connection

This type of connection uses Ethernet ports and cables.

Itis used when a printer is shared on various computers, or various computers use share the same

printer.

User-Guide_EvolisDriver_Macintosh ENG 2021123
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https://www.evolis.com/sites/default/files/drivers/58040_1249305_Network_administrator_manual_KU034_ENG_A1.pdf
https://www.evolis.com/sites/default/files/drivers/58040_1249305_Network_administrator_manual_KU034_ENG_A1.pdf

E
D thernet Cable
i,
\e
=

Ethernet cable

| b b

8.2.1. Checklist Before Starting

Do not plug at the same time the USB cable and the network cable.

Firewall and Antivirus : must be set to authorize communication on port 9100 (Evolis raw
printing port). You must have at least “power user “rights to perform Evolis network printer
installation.

IPV4 protocol: Evolis printer is compliant with IPV4 communication protocol only (not IPV6).
Multicast: pay attention that the protocol used to discover the printer on a network is
multicast so then the routing table on your network equipment (router, server ...) must be
configured accordingly to your network architecture to allow communication.

Broadcast, HTTP, HTTPS and ICMP dedicated ports must be allowed.

Led Status at the rear of the Evolis printer must be as in the following example:

Primacy example

Green LED

On = 10Mbit/s
Off = 100Mbit/s

J(m
dl
)

=5
OL

Orange LED

On = Printer connected to network

Blinking = Printer connected and network traffic
is working

8.2.2. Setting a Fixed IP Address on the Printer

By default, printers do not have a configured IP address.
You need to configure it manually.

8.2.2.1. Collecting the Required Information

Make sure you have access to the following information:
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o IP address of your computer network card (ex: 192.168.1.23)
o Subnet mask of your computer network card (ex : 255.255.255.0)

8.2.2.2. Configuring your Printer IP Address

NOTE In most situations, you will need to request those settings to IT department or technical
team of the company where you plan to install the Evolis Network printer.

For this first step, your printer must be connected to the computer through a USB cable.

Step 1: To set the address and other settings, use the Card Printer Direct Command Tool (please

refer to section Accessing the ComTool)

Command: |Pip;=;10.0.0.2

Answer: 10.0.0.2

Track1

Track2

Track3

Encode

Step 2: send commands in the following order:

Read

Card Printer Diract Command Tool

.:". Ut ‘

Eject

Identify

Upgrade

Type of printer:
Serial numbser
Kit o3 mumior

Firfrnawang version.

Quit

Cancel

S

1. Rip to read the current IP address of the printer and check the compatibility with your

computer IP address

2.Pip;192.168.0.1 (example)

3.Penm;255.255.255.0 (example) to set the Ethernet subnet mask / Renm to read it
to set the Ethernet gateway and Pews; ...... to set the Ethernet WINS

4.If necessary, Pegw;.....
server.

Step 3: You can now unplug the USB cable and connect the Ethernet cable.

Now go to Finishing the Printer Conﬁgurationgﬂ

User-Guide_EvolisDriver_Macintosh ENG 2021123
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8.2.3. Setting a DHCP Address on the Printer

You may want to use the DHCP configuration if you use a switch to connect one or various printers
(and/or computers) to a DCHP server (see section Using a Switch).

8.2.3.1. Configuring DHCP address

By default, Evolis printer are configured in DHCP mode. But if you have already changed this mode
into a static IP address and you want to go back to a DCHP adress, then follow the procedure below.

Step 1. Connect printer and computer through the USB cable. The EPS must be installed in Minimal
Mode on the computer(s).

Step 2. Configure the printer in DCHP mode. You can choose the configuration that best suits you:

Option #1: Set the address manually

Use the Card Printer Direct Command Tool (please refer to section Accessing the ComTool)

[ ) Card Printer Direct Command Tool

Command: | Pip;DHCP) Execute Identify WRCCH TR  (FIEEy
Serial number: 10000868693

Answer: OK Upgrade Kit head number: 285-EB803334
Firmware version: 1943

Track

Track2

Track3

Encode Read Eject Quit

Be extremely careful with the characters. The presence/ absence of spaces and capital
letters is important.

Enter the commands:
2.type Rip to read the IP address

3. enter Pip;DHCP
4. Enter Rip;1.The answer must be [IP address] Auto (see the example below)

5. to configure the subnet mask, enter Penm;255.255.255@xampl/e)

Option#2: Reset factory configuration

e From the Comtool:
Type Rmp;E

User-Guide_EvolisDriver_Macintosh ENG 2021123
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It will reset the DHCP configuration and disable the Wi-Fi option (if available)

¢ You can also reset the configuration through a long push on the switch on/off button of the
printer.

Option #3: Enable DCHP mode through the LCD screen

MAC 00:1A:FD:05:48:29 MAC 00:1A:FD:05:48:29

DHCP an

DHCP

1P

Mask

Step 3: Unplug the USB cable and install all the hardware equipment (please refer to diagrams in
section Using a Switch). Make sure the printer is switched on and the Ethernet cables are plugged.
Make sure to retrieve the IP address provided by the DHCP server to the printer. Then go to

Finishing the Printer Conﬁgurationgﬁ.

8.2.4. Usinga Switch

ol g
]
xc"“’:o
(\e e )
eﬁ
@X/
Ethernet cable =] o]
D el Ethernet cable I
oy 6}4
5%
Zer,, L=
3,
% T
[#]
|

20



E
e,
TRl Ethernet cable
\e
i,

] -
e,

e,
fq@tc
D Ethernet cable ETeTeT
P

Switch

IIDE

DHCP server

Use the:
- DHCP protocol if your switch is connected to a DHCP server (Setting a DHCP Address on the
Printer)[ 19]

[47)

- fixed IP address otherwise (Setting a Fixed I[P Address on the Printer

8.2.5. Adding the Printer to the List

Once you have set the printer IP address on the printer, you need to add the new printer in the list.

Step 1: Open the Apple Menu to access to the System preferences>Printers & Scanners:

User-Guide_EvolisDriver_Macintosh ENG 2021123
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[ ] i3 System Preferences ) |

E @ B E O & @ If

General Deskiop & Dock Misgion Language Security Spotlight Notifications

Screen Saver Control & Region & Privacy
( L]
I -
b = w P
COs &DVDs  Displays Emerng Keyboard Mouse Trackpad Printers &
Saver Scanners
© . @ 0 =
iCloud Internet Extensions Network Bluetooth Sharing
Accounts |
|
|
" — F S
2 ® @ ¢ B m © ©
5]
Users & Parental App Store Dictation  Date & Time Startup Time Accessibility
Groups Controds & Speach Disk Machine

Step 2: Click on + to add the printer.
€

i i c

.;7. Default
I

| Address:

Add

Search

In the IP tab (or symbol of the world)>Protocol, select HP Jetdirect - Socket :

—.
Add

Protocal:  HP Jetdirect - Socket

Lipdvn Blank for dolall gueus,

Default printer: | Padns:

Default paper size: | |
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Step 3:In the Address field, enter the IP address of the printer.

rr. ON ) Add Printer

B ® @

Address: |192.168.1.78

Valid and complete host name or address.

Protocol: HP Jetdirect - Socket

¢]
A

Queue:

Leave blank for default queue.

Click on Add, then OK.

Setting up "192.168.1.78.."
i Make sure your printer's options are accurately shown here so you

can take full advantage of them.

' Duplex Printing Unit

User-Guide_EvolisDriver_Macintosh_ ENG 20271123
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The printer is now shown as online in the printers list:

EVOLIS Primac
- EVOLIS Badgy200 v

> e Offline

&> EVOLIS Edikio Access
% ' e offline

Open Print Queue...

Options & Supplies...

- EVOLIS Edikio Duplex

@ Offline
Support’s MacBook Pro

|[ BeAE e P EVOLIS Primacy CUPS 6.6.2.138 English

© |dle, Last Used
Idle

Step 4: Go to Checking Connection With the Printer|24]

8.2.6. Checking Connection With the Printer

There are two ways to check the connection with the printer:

Option #1
Open awebpage and enter the IP address of the printer in the search field and type on Enter.

The page displayed is the following:

eoe M 0 192.168.1.78

) 192.168.1.78 - Login Admin

eveLIS

Printer status:

Model: Primacy
S/N: 10000868693
Kit nb: E6903799
Firmware: 1943

Accessing this page means that your computer is connected to the printer.
If this page is not displayed, go to Troubleshooting section.

Option #2 Ping Command
Open the Terminal (Finder>Applications>Utilities>Terminal) and send the ping command:
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O] @ support — ping 192.168.1.78 — 80x24

For more details, please visit https://support.apple.com/kb/HT208056.
Supports-MBP:~ support$ ping 192.168.1.78

PING 192.168.1.78 (192.168.1.78): 56 data bytes

64 bytes from 192.168.1.78: icmp_seq=0 ttl=100 time=0.646 ms

3.Ifthe answer is as written in the screenshot above, then the ping test is positive and the computer
can communicate with the printer.
If not, go to Troubleshooting section.

8.3 Assigning the Driver Version

To check that the driver was assigned to the printer that you want to use, go to System
Preferences>Printers&Scanners.

Click on the + button.
Click on the name of the printer. Go to Use>Select Software and click on Add.

If the the driver assigned is not the adequate one, click on the Use field and search for the adequate

driver.
[ Printer Software K

EVULIS UUaIYs Lara Printer UUPS 4.13.449. 20 Frencn
EVOLIS Edikio Access CUPS 6.6.1.110 English
EWVOLIS Edikio Duplex CUPS 6.6.1.110 English
EVOLIS Edikio Flex CUPS 6.6.1.110 English
EWVOLIS Elypso CUPS 6.6.2.138 English
EVOLIS KC100 CUPS 6.6.2.138 English
EVOLIS KC200 CUPS 6.6.2.138 English
EVOLIS KM2000B CUPS 6.6.2.138 English
| EVOLIS KM500B CUPS 6.6.2.138 English
EVOLIS Pebble Card Printer CUPS 4.13.49.26 English
| EVOLIS Pebble Card Printer CUPS 4.13.49.26 French
EVOLIS Primacy CUPS 6.6.2.138 English

J Cancel m

Name

| | 1
b § . L Q !
—
EVOLIS Primacy

Mame: |EVOLIS Primacy 2

Location: |Evolis's Mac

€

Use: | Select Software...

Add
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Teoe Add

= & = Q search

Default P Windows Search
MName ~ Kind
EVOLIS Primacy USB

Name: EVOLIS Primacy

Location: |Evolis's Mac

1 Use: | EVOLIS Primacy CUPS 6.6.2.138 English

Add

If the driver assigned is not the adequate one, please follow the procedure below:

Step 1: From the computer main menu, click on System Preferences.
n System Preferences Edit View W

About This Mac

System Preferences...
App Store...
Recent Items >

Force Quit System Preferences X {3

Sleep

Restart...

Shut Down...

Lock Screen ~¥Q
Log Out Support... 48Q

Step 2: Select the current printer and click on the + button.

Click on Use>Select Software.
Location:

Usa: Manaris DastCrrint Drintar q
Auto Select

¥ Generic PostScript Printer
Generic PCL Printer

Other...

Then select the adequate version and click on OK.
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Printers
<> EVOLIS Badgy200
v Paused
@ EVOLIS Badgy200 2
¥ e Offline
@ EVOLIS Badgy200 3
¥ e Offline
"» EVOLIS Edikio Flex
' ® Offline
i EVOLIS Elypso
I. ® [dle

u.' EVOLIS Primacy
— @ Offline, Default

Printers & Scanners

EVOLIS Primacy 4

Open Print Queue...

Options & Supplies...

".' EVOLIS Primacy 4 5
— o Idle |
w11
1
Printer Software
Q

EVOLIS KC100 CUPS 6.6.2.138 English

EVOLIS KC200 CUPS 6.6.2.138 English

EVOLIS KM2000B CUPS 6.6.2.138 English

EVOLIS KM500B CUPS 6.6.2.138 English

EVOLIS Pebble Card Printer CUPS 4.13.49.26 English
EVOLIS Pebble Card Printer CUPS 4.13.49.26 French

EVOLIS Primacy CUPS 6.6.2.138 English

Cancel
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Name

EVOLIS Primacy

Location: \support's MacBook Pro

Name:

Use:

Search

v Kind
uUsB

|EVOLIS Primacy 2

Select Software...

<

2

Add
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9. Accessing Printing Settings

There are two ways to access the settings:
Option #1: Your card designing application allows direct access to the driver settings
Step 1: From the software, click on Print.

e Access in TextEdit:

ZIEW Edit Format View Window

New 8N ‘

Open... #$0 ., st
Open Recent > ‘
Close BW =
Save... £ i
Duplicate £ 38S

Rename...

Move To...

Revert To >

Export as PDF...

Show Properties X3P

Page Setup...

Click on File>Print

If necessary, click on Show Details and select Printer Features under the Orientation field:

[ ] Untitled — Edited "
v | | Helvetica S)[Reguar  ¢li2 v mm .= B I UE=== w3)i=v i

Printer: @ EVOLIS Primacy

Presets:  Default Settings
Copies: |1

Pages: © All
From: 1 to: 1

Paper Size: = Other a 210 by 297 mm
5 B TN N
Orientation: ' | #/ IZ

v TextEdit

Layout
Paper Handling
Cover Page

L Printer Features

? PDF Hide Details Cancel

° Untitled — Edited
av || Helvetica ) reguar ¢z |v | M) (B 1 UBI== =) w0l i=y

Printer: @ EVOLIS Primacy <
n Presets: Default Settings ™
Copies: | 1
Pages: © All
From: 1 to: 1
Paper Size: | Other 210 by 297 mm
= [
orientation: T# Taw
Printer Features

Feature Sets v General
Ribbon
e —— Rotate by 180 (fron  Graphical settings.
10f1 Rotate by 180 (bacl Varnish adjustment
Advanced color parameters

Card insertion: D  Advanced parameters
Encoding

Card exit: | Defaul e g

Card ejected in error:  Default selection [

Card pre-loading: | Off

2, POF ] Hide Details Cancel
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e Access in Cardpresso:
Go to Print>Print Settings>Advanced Options>Printer Features

fiew To

U
[ =¥

|

?

Printer ‘ ||+ 192.168.1.118 . 9_

Manufacturer
Driver EVOLIS Primacy CUPS 6.6.1.102 English

Paper Size { Card

| ’ I
- J \Aavanced Options | D

Dimensions 86.002 mm x 54.852 mm

Orientation ‘ [ | Landscape

Print Layout

CardModel | = CR80

Print

Printer: | 192.168.1.116

Presets: Default Settings

v Layout '
Paper Handling |

Cover Page E

1 Border: = None a

Two-Sided: = Off
| Reverse page orientation
" Flip horizontally

rint Options

»Driver
vRendering
»Black
»Antialiasing
»Composite black replacement
vAdvanced
»Rotate 180
»Flip Horizontal
»Flip Vertical
»Use Colored Card
»Print Jobs

OK

| T e

For example, to change the ribbon settings:
In Feature Sets>General>Ribbon Type, you can change the ribbon type in the drop-down menu:

FA4

l@f 4t
MEHESE
'!#"‘-lﬂ
‘B al
c®; 9T
I:.:. 2
el
16t

2 | poF [ | Hide Details

@ =) FAQ Badgy utilities terminal

Q

Printer: | @ EVOLIS Badgy200

oo

Presets: = Default Settings

Copies: |1 Two-Sided
Pages: © Al
~From: 1 to: 1
Paper Size: | Other 210 by 297 mm

Orientation: T|?I Ii:
Printer Features

Feature Sets:  General

Ribbon type v 5 panels color ribbon - YMCKO
Black Ribbon - K

di

Step 2: To save the driver settings, go to Presets>Default Settings and Save Current Setting as

Preset...

You will be able to use the Last Used Settings to print your future jobs.

User-Guide_EvolisDriver_Macintosh ENG 2021123

29



Option #2: The card designing software does not allow direct access to the driver settings

You can access the driver through a webpage interface (called CUPS). Please follow the procedure
below:

Step 1: Open a webpage and type in the following address: localhost:631/admin

Step 2: The web interface may be disabled, as shown below:

@ Safari File Edit View History Bookmarks Window Help G Tueld:ad Q =

[ ] ® < [EH] localhost & t ) +

Neb Interface is Disabled

"he web interface is currently disabled. Run “cupsctl Weblnterface=yes" to enable it.

In this case, activate the interface as follows: go to Finder>Applications>Utilities>Terminal.

!En Eﬂ&@t

[ ] [ ] [58) Utilities
= » s A
= > ¢ c
s (o 4
e ¥
Activity Monitor AirPort Utility Audio MIDI Setup Bluetooth File Boot Camp ColorSync Utility
Exchange Assistant
% l y t:} %
i \ 7 4 / !
B W K X
Console Digital Colour Disk Utility Grapher Keychain Access Migration
Meter Assistant
) s > )
© @
“ N P
Screenshot Script Editor System VoiceOver Utility
Information

In the interface of the terminal displayed, enter cupsctl WebInterface=yes and click on Enter

Ne e & evolis — -zsh — 80x24

Last login: Tue Apr 28 18:11:45 on console
evolis@PEvoliss—Mac ~ % cupsctl WebInterface=yes
evolis@Evoliss—Mac ~ % [I

Step 3: The web interface is displayed:
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http://localhost:631/admin

e0e® < (> D localhost ¢ s} a g
CUPS.org Home WCIMINISIEGLLM Classes Help Jobs Printers

Administration
Printers Server
Add Printer  Find New Printers Manage Printers Edit Configuration File ~ View AccessLog  View Error Log  View Page Log
Server Settings:
Classes Advanced »
Share printers connected to this system
Add Class  Manage Classes Allow printing from the Internet

Allow remote administration

Use Kerberos authentication (FAQ)
JObS Allow users to cancel any job (not just their own)
Save debugging information for troubleshooting

Manage Jobs
Change Settings

RSS Subscriptions

Add RSS Subscription

Go to Printers>Manage Printers and click on the adequate printer:

CUPS.org Home Administration Classes Help Jobs I _

Printers
Search in Printers: o Search | | Clear
Showing 6 of 6 printers.

Queue Name Description Location Make and Model | Status |
EVOLIS_Badgy200 EVOLIS Badgy200 Evolis's Mac EVOLIS Badgy Card Printer CUPS 4.13.49.26 English  Idle
EVOLIS_Edikio_Access EVOLIS Edikio Access Evolis's Mac Edikio Access CUPS 6.6.1.110 English Idle
EVOLIS_Edikio_Duplex EVOLIS Edikio Duplex Evolis's Mac Edikio Duplex CUPS 6.6.1.110 English Idle
EVOLIS_Edikio_Flex EVOLIS Edikio Flex Evolis's Mac Edikio Flex CUPS 6.6.1.110 English Paused
EVOLIS_Edikio_Flex_2  EVOLIS Edikio Flex 2  Evolis's Mac Edikio Flex CUPS 6.6.1.110 English Idle
EVOLIS_Primacy EVOLIS Primacy Evolis's Mac EWVOLIS Primacy CUPS 6.6.2.138 English Idle

Step 4:In the Administration menu, select Set default options:
® e < > O localhost ]

o
B
1+

Set Printer Options

Set Default Options for EVOLIS_Edikio_Flex

General Ribbon Graphical settings Varnish adjustment Advanced color parameters Advanced parameters
Banners Policies

Advanced parameters

Monochrome printing speed: 10 [

Set Default Options

You can now change the settings as explained in chapter Changing Printer/Lamination Module
Properties@.
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The different ways to access printing settings are explained in section Accessing Printing Settingsmﬂ

NOT;E Watch this video to understand better the encoding and printing processes of an Evolis
printer: How does a plastic card printer work?

Various softwares may be used to create a design and patterns on the card that you want to print:
- Evolis © applications: Cardpresso, Badge Studio, Edikio Price Tag, etc
- Macintosh® applications: TextEdit.

10.1 General

Collate: this feature is linked to the printing order (if the software used enables it)

For the other settings, go to the next sections:
- Card Orientation
- Feeder/Hopper

10.1.1. Rotate

Use this feature to change the orientation of your design on the card.

Step 1: Keep portrait orientation if your design is oriented vertically and tick landscape orientation if
your design is oriented horizontally.

Step 2: Rotate each side (front and/or back) by 180°: this is especially useful when your design is
made of a dark color first and then a lighter color.

In this case, the darker color may bleed onto the light color.

Itis also useful when printing with a half-panel ribbon (see section Short Panel Management)

User-Guide_EvolisDriver_Macintosh ENG 2021123 32


https://www.youtube.com/watch?v=X6j7eXwtpdA&feature=youtu.be

USE CASE #1:
dark and light
colors

The card contains two colors: red (dark color) and yellow (light color).

Printing result when the rotation was not modified by 180°:
=> the red color has bled on the yellow color, because the first color printed
was the darker one

Printing result when the rotation was modified by 180°:

=> no color bleedingissue, as the first color printed was the lighter one
(grey color)
The line between colors is frank, compared to the first image:

USE CASE #2:
printing dual-
sided cards
with a simplex

@ printer
(back-side
rotation)

To print a dual-sided card on a printer that does not have the duplex@
module activated, proceed as follows:

Primacy e,
Primacy  e===@)
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10.1.2. Cards Feeding/Exit
NOTE Itis recommended to use default settings, as they are adapted to the current printer.
However, for specific printers, changing default settings may be necessary. Details will be
providedin the Use Case sections.

10.1.2.1. Card Insertion

The insertion of the card in the printer is the first step of the printing process.

Default selection: recommended setting according to
Print the type of current printer

Printer: | © EVOLIS Primacy B For example, on a Zenius printer, the default option is
| Bisasiz] Dsfouit Settings B the card insertion through the feeder, even if manual
Printer Peatures B insertion is also a possibility ("Manual feeding" option)
Feature Sets: = General a
1 Rotate by 180 (front): = No ] . . .
O Feeder: the card is fed using the classic feeder
; Rotate by 180 (back): No a
| Card insertion v Default selection l |
Cardeit | 0 oot - oction Automatic selection: the card is fed by using either
Cartjsjacted]  Merualfoecing ) ! the classic feeder or the manual feeder (as long as your
Cord pre-loadin: | ot B printer has a manual feeder), depending on the
2) (poF g | ride Derais cnce | @M Presence of the card on any of the feeders

Manual feeding: the card is hand-fed through the
manual feeder

USE This printer has two card-feeding options:
CASE: - 50-cards input hopper
- manual feeder

using a
Zenius In case you only need to print one card or two cards at a time, you should select
printer Manual feeding.
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10.1.2.2. Card Exit

The exit of the card is performed at the end of a successful printing process.

Printer Features () Default selection: recommended
setting
Feature Sets: General
Rotate by 180 (front):  Off Rgect box: printed cards exit in the N
reject box, at the rear of your printer, if it
Rotate by 180 (back): Off is available
Input Tray:  Default selection This option is also necessary when you
Output Tray:  Default selection want to use the pre-loading feature
) (please refer to section Card Pre-
Reject Box v Default selection | Loading)

Card pre-loading Reject box

o} H . I
S e Output hopper: printer cards exit in

the front output hopper

10.1.2.3. Card ejected in error

The ejection of the card is performed at the end of a failed printing process or upon a user manual
action.

Frinter Features v . .
© Default selection: recommended setting

Feature Sets:  General & . .
Output hopper: rejected cards come out in
the output hopper, at the front of your

Rotate by 180 (back): Off e printer

Rotate by 180 (front): Off e

Input Tray:  Default selection

Reject box: rejected cards come out in the
reject box, at the back of your printer or
under it, depending on its design

Output Tray  Default selection |

Reject Box ~ OutputHopper |
Reject box

Card pre-loading.
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10.1.2.4. Card Pre-Loading

NOTE I This feature is only on the following printers, equipped with a reject box: Primacy and
Elypso.

Pre-loading means that up to two different cards are used by the printer at the same time:
- oneisin the loading phase
- another one is in the printing phase

Pre-loading of the card is used to increase the card-feeding speed, whenever the conditions make it
possible.

Two conditions must be met before using this setting:
- the Card exit setting must be defined on Reject box
- the ribbon used is a monochrome ribbon

Select On to set the pre-loading of the card.
General
Collate: @True  False
Rotate by 180 (front): ~o B
Rotate by 180 (back): ~ B
Card insertion: Dpefault selection a
Card exit: Default selection a

Card ejected in error o " selection <]

Card pre-loadindZl

Set Default Options

The printing process of the card is faster, as the card is ejected at the back instead of the front: its
path inside the printer is only one way.
In this case, you should install an output hopper on the printer:

As the ribbon used has only one color, the card does not need to go through different passes inside
the printer.

N OT;E The reject box has a capacity of 50 cards: please make sure to empty the box before itis
full.
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10.1.2.5. Specific Settings for Kiosk (KM2000) printer

Card Insertion

']

+ Default selection

Feeder
Automatic

Bezel

Default selectit;-r'\"i-s;-fgéder

Card Exit

Default selection is bezel

Card ejected in error
Default selection is lower reject slot

Feeder configuration
Input Tray: pefault selection B

Output Tray EFEEREErTg |

Reject Box OCutputhopper )
Rear side

Set Defz Lower reject slot

Automatic selection: cards printed are retrieved from feeder 1, then
from feeder 2 when feeder 1 is finished, etc.

Alternate feeding: one card is retrieved from feeder 1, then one card
from feeder 2, then one card from feeder 3, etc.

None: when Card insertion is set on Bezel

10.1.2.6. Specific Settings for Kiosk (KC) printers

KC printers are the following:
- KC Essential
- KC Prime
- KC Max

According to the the printer specific features and the way they are installed in the self-service
terminal, the user can select different settings:
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Example of a KC Prime in a
self-service terminal

KC Essential/l KC Prime

Card Insertion and exit:
- on the front side or the rear side on a KC Essential printer
Input Tra" + Default selection !.

Output Tray Automatic )
REjECt Box Front side )
Rear side I

Input Tray: obefault selection B

OUtPUl Tray v Default selection !,

Reject Box lowerrejectsiot )
Front side .

Set Defz Rear side

- on the feeder/output hopper or the rear side on a KC Prime printer

=

Input Tray EEETETTg |
)

Output Tray Feeder

s Aut ti
Reject Box M )
Rear side I

Set Default Options

Input Tray: pefault selection B

Output Tray gy |

Reject Box Output hopper )
Rear side

Set Defz Lower reject slot
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Lower reject slot is also possible on both printers.

Card ejected in error:
Lower reject slot and rear side are possible on both printers.

- front side is a possibility that is specific to KC Essential printer
Input Tray: Default selection B
Output Tray: Default selection B

-

RE]ECt Box v Default selaction !
Lower reject slot
Set Defé  Front side

Rear side

- reject box is a possibility that is specific to a KC Prime printer
Input Tray: befault selection
Output Tray: Default selection B

=

REjECt Box + Default selection !

Output hopper
Set Defé  Rear side

Lower reject slot

10.2 Ribbon

10.2.1. Ribbon Manual Selection
Step: Tick Select the ribbon type and choose the type of ribbon according to your wish.

Ribbon
Ribbo
SHORT YMCKO -
Duplex Mode |, .« ]
Resolution SHORT YMCKOKO l
KO
BLACK
SetDefé  WHITE
RED
GREEN
BLUE

SCRATCH OFF
METAL SILVER

METAL GOLD
SIGNATURE

BLACKFLEX

BLACK PRIME
HOLO

Available ribbons are the following:
Type of ribbon Description and Use Cases
YMCKO Five-panel ribbon with the following colors: yellow, magenta,

cyan, black and overlay.
This is the default color ribbon used in Evolis printers.
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Type of ribbon

Description and Use Cases

Compatible printers: Badgy (the ribbon is adapted to the
printer size), Zenius, Primacy, Elypso, KC200/200B

"SPENCER
UNIVERSITY

Wahictity

SHORT YMCKO

Also called half-panel ribbon

It has the same colors as the YMCKO ribbon, but its panels are
half the size.

Itis used to print half or a third of the card.

YMCKOK

6-panel ribbon with the following colors: yellow, magenta,
cyan, black, overlay, black
Compatible printers: Primacy, Elypso

I

SHORT YMCKOK

6-panel ribbon with the following colors: yellow, magenta,
cyan, black, overlay, black

This ribbon has the same colors as the YMCKO ribbon, but its
panels are half the size of the YMCKO ribbon.

Itis usedto print half or a third of the card.

Compatible printers: Primacy, Elypso

SHORT YMCKOKO

7-panel ribbon with the following colors: yellow, magenta,
cyan, black, overlay, black, overlay
Compatible printers: Primacy, Elypso, KC200/200B
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Type of ribbon

Description and Use Cases

Two-panel ribbon with the following colors: black and overlay

Compatible printers: Zenius, Primacy, Elypso

With Black (K) Panel Varnish done with
Print Logo & Text Overlay (O) Panel

| |
™ | W
(G Clean’up

8400 Sanis Monica Bivd.
West Hollywood, California B0065

Tel: [213) 5550115
Fax: (213) 5550118

Ernim Gt Lamgn B M e (s Titen w8 T opbon

MONOCHROME (black, white,
red, green, blue, metallic gold
and metallic silver)

One-color ribbons
Compatible printers: Zenius, Primacy, Elypso
Print

Lc:|rgo & TTxt

r_ l l i :
G Clean’up

8400 Santa Monica Bid.
Wesl Holfpwood, Calfforna 900689

Tel (213) S55-0115
Fax: (213) 555-0116

| Evomms crwster samgir Lioag Manooteomes £ a0 S0 W B oplan
\_ J

Continuous ribbon which applies a edge-to-edge hologram
varnish to increase the security of the card

Not compatible with smart contact cards or magnetic stripe
cards

Compatible printers: Zenius, Primacy

SCRATCH OFF

Continuous ribbon which produces a grey area that can be

scratched off
Compatible printers: Zenius, Primacy, Elypso, KC200/2008
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Type of ribbon

Description and Use Cases

Evels sampic card is print with SoratobolT rikbon
{ Numbers. are hidden Under The Patch |
Seratch the patch & see the No.

LY !

To use this ribbon:

1. print a text on the card, with the ribbon of your choice
2.inyour card designing software, edit an area to apply the
scratch-off. Fill the area with any color. Make sure the area
covers the text printed before. Place the scratch-off ribbon
into the printer and print the scratch-off design

SIGNATURE

Continuous ribbon which enables to apply a rectangular area
on cards, where a signature can be written
Compatible printers: Zenius, Primacy

R ST - T ‘W) L, i RaED

BT R
.‘-ﬁ. Qﬂiwu it i

BLUE Bans 7 P ) - e

BLACKFLEX

Black monochrome ribbon.

Due to the composition of its ink, this ribbon can be used with:
- standard cards: PVC, PET, PC,

- and cards that cannot be printed with the traditional
monochrome black ribbon: ABS, paper

Compatible printers : Zenius, Primacy, Elypso, KC200/200B

This ribbon is useful when the printing result with the
traditional black ribbon is not the expected one, even after
changing the concerned driver parameters. Please refer to
section Front Side Graphical Settings for more details.
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10.2.2. Duplex Mode

The Duplex % mode enables the user to print your card on the front and back sides during the
same printing job, with no manual action during the printing process.
ur

Print
Printer: @ EVOLIS Primacy a
Presets: Default Settings a
Printer Features a
Feature Sets: | Ribbon a
Ribbon:  YMCKO 2]
! Duplex Mode v Simplex l

Front Color / Back Color
Front Color/ Back Monochrome
Front Monochrome / Back Monochrome

| Front Monochrome /[ Back Color
?) (POF R e

Resolution:

Front color/ back color | With these options, the varnish settings are set by default on Full varnish.
Front color/ back
monochrome
Front monochrome/ | To change these settings, please go to sections Front Side Varnish
back monochrome Adjustment and Back Side Varnish Adjustment.

Front monochrome/
back color

This option is used when printing on the two sides of the card: you may want to use different ribbon
settings for each side.
Printers concerned can be the following ones : Primacy, Elypso and Duplex.

As a consequence, itis:
- visible when your current printer has an integrated flip-over (= duplex) module
- not visible when your printer does not have an integrated flip-over (= duplex) module

To check the presence of the flip-over module in your printer, go to Comtool (please refer to

Accessing the ComTool )|?9'1 and enter the Rflo command. If the answer is Enabled, it means the
module is installed.
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Step 1: Select the type of duplex mode according to the type of ribbon that you are using:

» You are using a YMCKO ribbon (full or half):

Type of duplex Use Case
mode
Front color/ back
color

Each side of the card is printed with different YMCKO panels@.

USE CASE

The setting used for the Black Panel Adjustment is set on All black dotsg
for each side.

NATIONAL ID CARD REPUBLIC OF EVOLIS

ST EEL'L N {:‘%3 i Photo & Background
lemNnmes ey & Picture in color
Tay&’x‘ Anne Mag/ £ | )
\‘Holder's signature | printed with the
3“7 (A l b Yellow (Y], Magenta
2 %%C- 21 g (M) and Cyan [C]

panels

i
ﬁ‘ﬁ
2
é:! <

q Dehvened by

Valid from
04 /0!/20.13
T

“o3 auzoza

Logo and texts in
real black printed
with the black (K
panel

Front color/ back

The front side is printed with the YMC colors and the overlay% will be
monochrome

applied onit. All black elements on the front side are printed with composite

bIack@.

The back side is printed with the black color (K panel). No overlay will be
appliedto the back side (varnish option is deactivated for the back side).

NOTE ISeIecting this option will use two YMCKO panels during the printing

process and skip some colors for the back side. If you do not want to
use your ribbon too quickly, we recommend that you select this
option only if you really need it.

USE CASE
For the front side: by default, the setting used for the Black Panel Adjustment
is set on No real black printed.
For the back side: by default, the setting used for the Black Panel Adjustment
is set on Black and White, but you can select another option (please refer to
section Black Panel Adjustment).
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Type of duplex Use Case
mode
ma ] ;- Photo & Background
Glmum 3 "'§ Picture in color
Tayxﬁiz Anne m:@?ff | )
printed with the
. Yellow (Y], Magenta
[M] and Cyan [C]
panels
041"04!2
4[20?
Logo and texts in
Yellow [Y], Magenta
[M] and Cyan [C]
panels
K panel is particularly adapted to barcodes and QR codes. Make sure to insert
them on the back side, with this option.
4 ™\
Back Side Data Like Text
If fourd, please retum the card, under unstamped letter, Barcode Is ps:inred with the
to the addross below: (K) Panel
Owens University
956 Royal Street
Hoston ZWS6 SHD
UK
\ i
Front YMC/ back KO| The card front side is printed with the YMC colors, and the back side is printed
with the KO (black and overlay) panels.
The only difference with the previous option is that the overlay is applied on
the back side and not on the front side (varnish option is deactivated for the
front side).
With these options, the varnish@ settings are set by default on No varnish on
both sides of the card.
Custom front
monocErome/ back To change these settings, please go to sections Front Side Varnish Adjustment
monochrome and Back Side Varnish Adjustment.
Custom front
monochrome/ back
color
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Itis strongly recommended to avoid printing flat colors on any of the card sides. Always
make sure to add patterns or characters to your flat color.

Indeed, flat color only causes the print head to warm too much as there is no other design
detail to lower the heat of the print head.
This issue may cause the ribbon to be stuck on the card and torn.

9y

) »
sa'y'sa
eleale
velve

MY Y

YOUR LOGO

® ©

» You are using a monochrome ribbon

Both sides are printed with the same color and no varnish% optionis possible as there is no
overlay panel in the ribbon

Step 2: Check the settings in Front Side Varnish and the Back Side Varnish windows.
Select Full Varnish if you want both sides of the card to have the varnish protection.

Never use the varnish% option on the side of a card that is already laminated.
It would not be useful and would produce various issues, including card jamming, tearing

of ribbon, unsticking of Iamination% film, etc.

10.2.3. Printing Resolution
Step: Select the type of resolution:

Resolution Use Cases

= Default resolution, adapted to most printing jobs and
300x300 dpi orinters

(size of design in pixels: 1016x648)

Adapted to printing jobs on most printer, if the size of
your design resolution is bigger

(size of design in pixels: 2032x1296 NOTE I Finer details can be printed, but the card

600x300 dpi==

size of printing rendering in pixels: printing process may be slowed down.
2032x648)
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Resolution Use Cases
1200x300 dpi Only when using monochrome ribbons, especially with a
(size of design in pixels: 4064x2592 | design of:
size of printing rendering in pixels: | - small characters in text areas
4064x648) - high resolution

NOTE |1 dot=0,12 mm

10.3 Graphical Settings

Please refer to the next sections: Front Side/Back Side Graphical Settingsm

For the specific feature on the definition of the text area, please contact your Evolis reseller or the
Support team.

10.3.1. Front Side/Back Side Graphical Settings

Those settings will enable you to adjust the color panels, so as to get the most optimal printed
result.

The Ribbon details tab provides the name of the ribbon currently detected in the printer.

To enable the back side graphical settings, make sure to enable the Duplexg Mode in the Ribbon
menu (for more details, see section Front Side and Back Side Settingslm

10.3.1.1. Brightness and Contrast

Step: Adjust the brightness and contrast of your colors.

Feature Use Case
Brightness of Increases the overall lightness of the image.
colour panelsg
Contrast of Increases the overall darkness of the image.
colour panels The higher is the contrast, the higher is the printing heat.
Increase o ‘h Increase
J :
s —
m Bailey HOPKINS Original Qm Bailey HOPKINS
A i Validity: 20/11/2016 ‘ha Validity: 20/11/2016
e Contrast
. — S | Bailey HOPKINS
s Validity: 20/11/2016.
":ﬁ; Bailey HOPKINS A
Decrease L A e Decrease
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10.3.1.2. Black Panel Adjustment

The user has two possibilities:
- using a pure black color (RGB code above 253)

- using a mix of colors (yellow, magenta and cyan panels): it is called composite black@

There are three different parameters associated with these two possibilities:

Feature Use Cases
Monochrome . . . _—
Resin Adjustment no real black printed: the black panel (K) is not used during the printing

process.
Only composite blackis used.
Itis especially useful for designs with only images

NATIONAL ID CARD REPUBLIC OF EVOLIS

Settings: No real black, front side with YMCO panels

Address:
1564 Sunset Boulevard,
Suncity, 95456

P<ITSPECIMEN<<TAYLORANNEMARYSTOCKDELL<<<<<<<CCLLLL
DO003258742LA<25L9<2I598<<<<<<<2ISATCCCCCLCLLLLLLO0

This card has been personakoed by an ©Fvolis card printer

Settings: back side with K panel

all black dots@: the black panel (K) is used for the whole design (text
area, images)
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NATIONAL ID CARD REPUBLIC OF EVOLIS

T If.-
|_|-:1- .

Settings: All black dots, front side with YMCKO panels

only black text: the black panel (K) is used only for text areas and barcodes

NATIONAL ID CARD REPUBLIC OF EVOLIS

| By 4 L
[ . "4’1,-'..

Setting: Only black text, front side YMCKO

If you have selected all black dotsﬁ or only black text, you may need to adjust the resin
monochrome setting. This setting is directly linked to the print head heat and to the thermal

transfer% technique.

must be more accurate.
You may need to:
- increase the resin adjustment (by default itis set on 10),
- decrease the printing speed.

NOTE I In case you want to print barcodes or text areas with small characters, the printing result

There are four different halﬂoning% parameters:
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Feature Rendering
Threshold i
Floyd
Dithering @
Dithering
Clustered
Dithering$
Clustered Dithering

When applying pure black color on the card, the monochrome resin adjustment is increased or
decreased in order to improve the density of the black color on the card.

Monochrome resin adjustment : it I .

Loy High

10.3.1.3. Printing Black Text: Use of Different Softwares

This section will compare various software used when printing black text areas, and explain the best
parameters to use in the driver.

The use case is to print a design that contains a background image and black text area: the image
must be printedin color and the text must be printed in pure black.
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Example of Card Design with Image and Text Areas

Some softwares detect the difference between text areas (bitmap) and images (vectorial) while
others do not.

Depending on the software you are using to design your card, you will need to set specific settings in
Black Panel Adjustment.

NOTE IPre—req uisite: add a Card format for Evolis printers

1.Open TextEdit application
2.Goto File> Page Setup>Paper Size>Manage Custom Sizes

3. Click on + and add a new format as follows:
-width:55mm
- height: 86mm
-top:0mm
- left:0mm
- right:0mm
- bottom : 0Omm
5. Save the new format with the name Card and click on OK
6. Close Text Edit
7.Go to System Preferences
8. Select Printers and Scanners
9. On Default paper size, select Card

1. Cardpresso
Text areas and images are detected.

It also works without black dots‘% on the images. It means that the RGB code used for the image
black areas is under 253.

Step 1: Do not forget to set the image as a background (clicking and pressing on control key)
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[E cardPresso XKL Edition (1.6.40) [Document1] - [m] X

CP File Edit View Tool Database Window Help

reEmE =) aaa &

n Y mremrn B R B B B s S == Irem
Position
— Shape
LN
: Alignment
| )
Rotation
[ ] Outline
Fill
.|
Image
T
[l ‘ From Disk |~ ‘
Z Title
g Ey—— \
i Source
[ :/_eipandmanualprojects/software |~ |
)
g | o Updated
Duplicat
s Rlaliciald 11 4 [ When Item Double-Clicked -]
i Soers o e Save with document
Raise
m Lower | Yes I~ ‘
) B Misend To Back Format
O] Export Image \ | Image Free format |~ \
Fit to Card | No |~ ‘
@ Open image editor
s
2 [0 ]
‘smm ‘

2. Preview
This is the default image editor on Macintosh platforms.
Difference between text areas and images is not detected.

Step 1: Go to Tools and set the image size in pixels is the resolution that you want to print

(1016x648 or 2032x1296 or 4064x2592) and save it.

For more information on the available resolutions, please refer to section Printing Resolution| 461
Go Tools Window Help

Show Inspector 38

Show Magnifier "
] Adjust Colour.. $C |
Adjust Size... ;

Text Selection

v Rectangular Selection
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Image Dimensions

Fitinto: ~ Custom B pixels
Width: 1016
o’ Exels BJ
Height: 648
Resolution: 72 pixelsfinch (%]

Scale proportionally

Resample image

Resulting Size

35.84 x 22.79 cm

171 KB (was 58 KB)

Step 2: For the procedure to define a text area, please contact your Evolis reseller or the Support
team.

Step 3: Directly from the image icon, right-click and click on Print.

10.4 Varnish adjustment

Varnish adjustment

Varnish Option (front
Varnish Option (back) gz;z::izgmap |

Varnish Adjustment (front): 10

Varnish Adjustment (back): 1o

Set Default Options

The varnish (= overlay) @, is available for all types of ribbons apart from the continuous ribbon (as
it does not have an overlay panel).

The varnish adjustments window allows you to adjust the varnish coating on cards and where to
apply varnish on cards.
The purpose is to protect the card from UVs and to increase resistance of cards to scratching and

fading up.
Feature Steps to follow /Rendering
No varnish As itis not possible to print on a card side that was varnished, use
No varnish is applied onthe | the No varnish option when you want to print:
printable area. 1.the "background" patternin afirst printing job
2.then the text in defined areas in a second printing job
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Feature Steps to follow /Rendering

Printed card is more| When all printing jobs are finished on the card, you may go to Full
exposed to wear Varnish or Custom bitmap option.

and tear
Full varnish Use this option if you have finished printing the patterns and texts
The printable areais covered| on you card.
with varnish.

In case you want to check that you have applied an overlay on your
card, check the brightness of the card.

TIP: A bright card indicates that an overlay was applied, as it reflects
the light of the environment.

Custom bitmap/Bitmap
File Please contact your Evolis reseller or the Support team.
You select aformat to apply
the overlay on the card

Applying an overlay with a
custom bitmap is especially
useful when you have a
magnetic or smart encoding
on your card.

USE CASE
You may want to apply a varnish on the back if your card is especially submitted to frictions.

For example, the repeated insertion in a reader, of a card equipped with encoding% capacities,
may cause scratches to appear.

Applying the overlayg-g on both sides of the card will add a useful protection.

You can also adjust the varnish value from 1 to 20. Default value is 10, but you may want to increase
the adhesion of the varnish, for example if the current varnish is too easily removable on the cards
that you previously printed.

10.5 Magnetic Encoding

Magnetic encoding uses the following support: a magnetic stripe on the card

0100100100010010
Track2

Track3

Before starting to encode your card, you need to insert the magnetic card in the printer feeder.
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|

Magnetic stripe on the
downside

The first card to be encoded is the one that is at the bottom of the cards stack.

Cardpresso software enables you to print magnetic encoding tracks (please refer to section

Encoding Using Cardpresso}@.

You can also develop your own encoding application thanks to Evolis SDK and the driver settings

(please refer to section Encoding Properties)Eﬂ

10.5.1. Encoding Using Cardpresso

Step 1: Insert the magnetic card in the printer feeder ( magnetic stripe on the down-side
and on the right of the printer)

Step 2: From Cardpresso, select the adequate type of magnetic card. Magnetic encoding is available
from XXS version of Cardpresso software.

& select Card Type

Card Types 46 Card Types [ A1 Card Types -]
Loco HICO LOCO ) miFare

DESFIRE
€320 ))
HICO !))) MIFARE )) NFC

Step 3: From the card designing window, click on the View card back button to display the
encoding tracks.
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) QaQa &

Step 4: Click one of the tracks to enter the content.

Track1:

lagjhagaihl |

Close

Cardpresso automatically
converts the content into capital
letters, as lowercase letters are
not accepted

CP File Edit View Tool Database Window Help

e B K = @[E

iii
o
jo
j&)
D:i

- -
‘ _ TRACK1: EVOLISCOMPANY
. - Track2:
T ‘ |4456677| I
’: Close
o

Step 5: From the right part of Cardpresso software, you can change the source of your track content,
then match your database content with each track.
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Step 6: To print the encoded card, go to File>Print and select Magnetic Encoding.

Advanced Options |§|

Printer | ||/ EVOLIS Primacy |~

Manufacturer

Item

Font

Keyboard Input | A

Print Counter
Print Date
| Keyboard Input

Database
When Item Double-Clicked

Save with document

[ M

Data Type

| Text Line |~ | | |

Font auto adjust

|New'_r |'|

NOTE For more details, please refer to the help available in Cardpresso software.

&

Driver EVOLIS Primacy CUPS 6.6.2.138 English

Settings Advanced Print Operations

& www.

Print Range
Number of different cards |1 =

Print Operations

Print Front

Print Back

Coples

‘ Number of copies |1 -

Magnetic Encoding

Read Magnetic Data

Step 7: To read the tracks you have just encoded, insert the card and go to the Comtool (please refer

to Accessing the ComTool }Fﬂ

Select the tracks and click on Read track(s).

10.5.2. Encoding Properties

Encoding settings in the driver are mostly useful if you plan to develop your own application in order
to use the encoding feature. You will have to use SDK 2.n.
For more information, please contact the Support team.

Step 1: Change the encoding standard for each track.
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Printer:  EVOLIS Primacy [

Presets: Default Settings ®]
Copies: |1 <
Pages: © All
From: 1 to: 1
Paper Size:  Other 210 by 297 mm (]

1SO1
1ISO2

Orientation: © & P9 Landscape

| 1S03 3s (]
SIPASS
Feature Se  C2 )
JIs2
Coercivity - ivity &

Settings Track 1 )
Settings Track 2:  None

Settings Track 3: None )

PDF @ Cancel m

The stripes can be configured in ISO, SIPASS, C2, JIS2 and C4 format.
See the tables below for information on the 1ISO 7811 and JIS2 (Japanese Industrial Standard)
standards.

4

ISO 7811 magnetic encoding standards

Stripe # Separator Density Character set Number of
characters
Stripe #1 A 210 bpi (bits per | Alphanumeric 79
inch) (ASCII 32-95)

Stripe #2 = 75 bpi Numeric (ASCII 48 40

62)
Stripe #3 = 210 bpi Numeric (ASCII 484 107

62)

ISO1 accepts up to 793 alphanumeric characters, from A to Z and from 0 to 9 along with ASCII
characters between 32 and 95.

ISO2 accepts up to 403 numeric characters, from 0 to 9 along with ASCII characters between 48 and
62.

ISO3 accepts up to 1073 numeric characters, from 0 to 9 along with ASCII characters between 48 and
62.

NOTE Character set: The “?” character cannot be used
Number of characters: Including the Start, Stop and LRC characters (automatically

handled by the magnetic encoder)

JIS2 magnetic encoding standards

Stripe # Separator Density Character set Number of characters
Stripe #1 A 210 bpi Alphanumeric 79
(ASCII 32-95)

The C2 and C4 configurations relate to custom mode and are reserved for future use.
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The SIPASS configuration accepts 21 characters, from 16 to 127 (ASCII characters).

Make sure not to apply an overlay@ on the magnetic stripe. If the overlay is applied on
the magnetic stripe, the reading of the encoded information may not be well performed.
To apply an overlay of custom bitmap file on the card (with no overlay on the magnetic
stripe), please refer to section Varnish adiustment@

Before starting the encoding of a card side, always check the parameter that was selected
in Varnish type: "no varnish" or "custom bitmap" are correct options whereas "full
varnish" is not a good option.

Step 2: Two types of coercivity are available for the magnetic stripe.

With Evolis cards, the following types are available:

Type of coercivity Meaning
Hico (high coercivity) high immunity level
Loco (low coercivity) low immunity level

The Comtool is used to retrieve basic information about the printer, send commands, upgrade the
firmware and manage the basic encoding features if your printer is equipped with the encoding
capacity.

Step 1: To access the Comtool, go to System Preferences in the Apple menu.

System Preferences
2. -000&
[*—J

Step 2: Click Printers & Scanners.
Select the printer in the list.

Click on Options and Supplies>Utility>Open PrinterUtility.
The Comtool is displayed.

User-Guide_EvolisDriver_Macintosh ENG 2021123 59



-
"

]

Answer:

Trackl
Track2

Track3

Command:

General Supply Levels  Utility

Open Printer Utility

Card Printer Direct Command Tool

I:l Execute Identify

Upgrade

Encode Read Eject

Type of printer:
serlal number:

Kit head numbar:

Firmware version:

Quit

From this window, various features are accessible:
- identifying the printer details
- sending direct commands (escape commands) to an Evolis printer
- testing magnetic encoding feature (if a magnetic encoder is installed)
- upgrading printer firmware

If the Comtool is not functional (this may be the case if your OS version is >10.12), you will
need toinstall it separately.
Please contact the Support team to access the application file and installation

explanations.

In case you are working on Mac OS 11 (Big Sur), the Comtool is not available.

11.1 Sending Direct Commands in the Comtool

Use the Command field to communicate with the printer.

Command: | Rfv

Answer: 1802

Track1

Track2

Track3

Encode

Card Printer Direct Command Tool

. - i cul ’ Identify Type of printer:

Serial number:

Upgrade

Firmware version:

Read Eject

Kit head number:

Edikio Flex
10000848351
268-EB602863
1802

Quit
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The most frequent commands are:
R means Reading
P means Programming

Some examples of commands:

Command Meaning Good answer
Rfv Read Firmware Version Firmware number is displayed
Rip Read IP Address IP address of the printer is
displayed
Stt Sequence Technical Card The card is printed and ejected.
The answer must be OK.
Pip;192.168.0.1 (example) |Program the IP address The new IP address is configured
and the answer must be OK.
Rflo Read the status of flip-over ENABLE => the module is active
module DISABLE => the module is not
active
Sa Sensors adjustment The sensors adjustment is
checked.

The answer must be OK.

TROUBLESHOOTING - Possible wrong answers are:
ERROR CDE => please check the command

Unable to communicate with printer => please check that connection cable is well plugged both
on the computer and the printer

In this tool, you can also read and encode the magnetic tracks when an encoding module is installed
and a magnetic cardis inserted in the printer.

For more details, refer to section Magnetic Encodingl 541and Track Settings.

11.2 Upgrading Firmwares in the Comtool

This procedure requires an Internet connection to download the latest updates from Evolis servers.
PRINTER FIRMWARE

Option #1: your version of MAC OS is under 10.12
1. Download the printer firmware file to your hard disk from the Download section of Evolis
website>Support and Drivers.
2. Connect your printer to your computer and switch it on.

3.  From the Comtool (procedure to access is explained in section Accessing the ComTool )[59]
click the Upgrade button.
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\
| : |
| General Supply Levels  Utility ‘

ﬁ Open Printer Utility

S
R
| —

®
!
I —

Card Printer Direct Command Tool

Command: l:l Execute Identify U T T

Serial number:

Answer: Upgrade Kt nead number:
Firmware version:

Track1
Track2

Track3

Encode Read Eject Quit

8.  Search the file downloaded to your hard drive, then click Open to start the upgrade process.
9.  The on-off switch on the control panel of the printer should flash during the firmware update.
Do not switch off the printer during this process.

Option #2: your version of MAC OS is 10.12 or higher
The printer maintenance tool (Comtool) may not be installed by default on your computer. Please
contact your Evolis reseller or the Support team.

LCD FIRMWARE AND GRAPHIC RESOURCES

1. Download the LCD firmware file to your hard drive from the Download section of Evolis
website>Support and Drivers.

2. Connect your printer to your computer and switch it on.

3. From the Comtool (procedure to access is explained in section Accessing the ComTool )I'ss)click
the Upgrade button.

Search the file downloaded to your hard drive: firmware file (firm) or graphic resources (lcdomp).
4.When prompted by the program, follow the instructions to select the printer and start the
operation.

The firmware transfer is in progress. Wait for the Ready status to appear on the LCD screen.

To check the firmware is well installed, go to the Comtool (please refer to Accessing the ComTooll s8]
) and send a Rfv command to the printer. The answer must be the firmware version that you just
installed.

N OT;E Only the upgrade is possible. It is not possible to downgrade the firmware version.
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This section aims at listing the steps needed to solve specific issues.

12.1 Connection Issues

¢ Printing job is not successful

1. Check that you have selected the right printer in the Print window of your application.

2. Check the connection with the printer (Checking Connection With the Printer)

Ifitis not successful, check the IP address of the printer is on the same network range as the

computer.

e Ethernet cable is not detected

If... Perform the following actions

» Checking Connection With the Printer is not 1. Change the Ethernet cable
successful
2.If using a switch, change the port of the cable
» The printer Ethernet port has a static orange
color (it is not blinking nor green colored) 3. Check your computer configuration (the
Ethernet card must be enabled and its driver
must be up to date)

4.Restart the printer

¢ Printer detection has failed
- check the firewall and antivirus policy: port 9100 must be allowed, as well as multicast
- the address of your computer must also be a IP/DHCP one

12.2 Printing Issues

12.2.1. Faded Colors

This type of result (faded colors) may be caused by using a wrong power supply.

Please refer to your printer User Guide to check the supply power that is adequate.
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12.2.2. TornRibbon

Step 1: Proceed to to fix the torn ribbon.

Use tape to put the panels@ back together:

V’,""’WWT«,”""N’" it Tres |

J

Step 2: Solve the issue to avoid another tear‘ing of the ribbon.

Various checkings may solve the issue:

Type of checking

Steps to follow

Check firmware version

From the Comtool, enter Rfv command.
If the command returns a wrong answer, proceed to printer

firmware update (Upgrading Firmwares in the Comtool)[e]

Check the printer sensors
working

From the Comtool, enter the Sa command.
If the command returns a wrong answer, please contact your
Evolis reseller or the Support team.

Check offsets settings

The ribbonis torn if a hot printhead goes down on the ribbon
when there is no card under it.
Please contact your Evolis reseller or the Support team.

Check temperature values
applied in the driver

The temperature may have been pushed to the max for the
black panel (when printing a barcode for instance).

For other designs, this setting may cause ribbon tearing issue.
As a reminder, default value for monochrome resin
adjustment parameteris 10.

Check the ribbon

A faulty consumable may be the cause of the issue.
Replace by aribbon from a different batch lot number.

Check printhead serial number

A printhead replacement or a mistake may have sent a wrong
value to the printhead.

In the Comtool, check that the answer to the Rkn command
matches with the barcode stuck on the printhead.

If the answer does not match, send the value displayed on the
barcode through the Pkn command or using the wizard.
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Type of checking Steps to follow

Check card surface / quality Check the card freshness: a simple test consists in bending
the card.

With time and/or bad storage conditions, cards become
brittle and their surface is not porous anymore.

12.2.3. Unreadable Barcode

In specific cases, the surface quality of some cards do not allow a good rendering of the barcode
printing, which makes it unreadable by the appropriate scanner.

DR TV

Resin adjustment setto 10
Monochrome printing speed set to 10

Example:

The barcode was printed using Evolis Printing default settings.

Procedure to improve the printing:

Step 1:Increasing the resin adjustment improves the result.

Resin Adjustment setto 16 Resin AdJustment setto 18

Step 2: If Increasing the resin adjustment does not produce a better print quality, decrease the
printing speed by dropping 2 points at first (go to section Advanced Parameters), :

0RO

Resin Adjustment Set on 20
+ Slower Printing Speed

NOTE I A slower printing speed produces a better ink adhesion on the card.

For an even better result, you can use a blackflex ribbon combined with the default settings of the
Print Center (resin adjustment and printing speed both set to 10).
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